
Getting Started with EndNote X3  - a brief guide 
 
EndNote is a specialised database program for storing and managing bibliographic references. It 
allows you to enter references manually and import references from library databases. You can add 
your own notes, abstracts and other material to the references. The references can be sorted and 
searched, and incorporated automatically into papers for publication. EndNote makes writing 
academic papers easier, not only by saving you time, but also by ensuring your references are cited 
consistently. 

This brief guide covers the basic skills required to get started using EndNoteX3. For more information 
the help screens in EndNote are very useful. These can be accessed by clicking on the Help option 
on the menu toolbar or the Help icon on the library toolbar. 

1. Installing EndNote 
 
Full instructions for installing Endnote from the CD are available from:  

This web page also includes information on common installation problems and contact details if 
further help is required. 

http://www.library.auckland.ac.nz/endnote/endnoteinstall.htm  

 
2. Keyboard shortcuts 
 
There are a number of keyboard shortcuts you can use with Endnote.  The most useful of these is 
Ctrl+W which closes the active window. Ctrl+N (new reference) and Ctrl+M (show all references) are 
also useful. 
 
3. Opening Endnote  

Locate the EndNote Program icon on your Start menu . (Start > Programs > EndNote > EndNote Program). 
Click on the EndNote Program icon. If this is the first time that you have used EndNote, you will see this dialogue 
box: 

 



 
 
 
 
 
 
 

 
 
 
 
 
4. Creating a new library 

Click the Create a new library graphic. (see above) 
You will see the following dialog box, with My EndNote Library.enl as the name of the new library. 

 
 
 
• Enter a name for your new library in the ‘File name’ area.  
• Click Save.  
• The new file is an empty EndNote library, showing “0 out of 0 references.”  
 
 
 

 
An EndNote file is called a library. It is a database containing a separate record for each reference. 
Each record is made up of several fields containing specific pieces of information. 
 
Although you can create as many libraries as you want it’s generally recommended that you 
maintain only one. All your references can be stored in the one library and labelled or grouped to 
reflect any particular subject interest. 
 
You can set up a default library, which will open automatically when you open EndNote. To do this, 
select: Edit --Preferences--Libraries 
 
 
 



 

The Preview Tab at the bottom of the library window will show you what your formatted references look like. The 
Search Tab is used for searching your library or a remote database. To close both the tabs, click on Hide Tab 
Pane. 

The Groups Pane at the left of the library window allows you to organise your references into groups. You can 
close the Groups Pane by clicking on the Groups option on the top menu bar and selecting Hide Groups. 

5. Backing-up your EndNote Library 
 
It is essential that you make a backup of your EndNote library in case disaster strikes! As well as 
saving a copy on the computer you are working on it would also be useful to save a copy on another 
disc or drive. You can use this copy to restore your EndNote Library if it is lost or damaged.  
 
Save a Copy  
 
You can save a copy of both your .enl file and its associated .data file to use as a backup or to 
send to someone using any version of EndNote.  
 
• Open your EndNote Library   
• From the File menu, select Save a Copy  
• Use the Save in: dialog box to select where you want to save your back-up copy.  

 
OR 
 
Save a compressed copy  
 
• From the File menu choose Compressed Library (.enlx) 
• Choose whether you want file attachments included and whether you want your entire library or 

just a section of it saved. 
 

 
 
 
 
 



6. Manually Adding References 

Click on the New Reference button on the library toolbar. You will now see a New Reference 
Window: 

 

 

 
 
 
 
 
 

 
 

 
Author 
 
There are several ways to enter author (or editor) names, either: 
 
First Middle Last e.g. D H Erwin 
OR 
Last, First Middle e.g. Erwin, D H 
 

• Only one author name can be entered per line. Press Enter to get another line. 
• If you are entering initials instead of full names, make sure there is a space between each 

initial.  
• If your author is a corporate body e.g. Manukau City Council you must put a comma after the 

last part of the author name e.g. Manukau City Council, Without the comma EndNote will 
interpret this author as Council, M C 
  

 
 

The Reference Type box is at the top of every new 
reference, indicating the type of reference being 
entered. Journal Article is usually the default 
reference type, but you can select any other type from 
the drop-down list. Different fields will appear for 
different reference types. 

• Use the Enter key to create a 
new line in a field, e.g. for a 
second author.  

• Use the Tab key to move down 
the fields.  

• Use the Shift+Tab keys to move  
back up the fields. 
 

 
 



Title 
• Enter the title only - do not add a full-stop at the end. 

 
Year 

• Do not add extra punctuation, such as brackets. 
 
Pages 

• Add pages in this format 123-35 or as 123-135. 
 

Once all data has been entered close the reference window (CTRL+W). EndNote will automatically 
save the information when the window is closed. The new reference will now display in your library.  
If you need to make changes to a reference after you have closed it, open the reference by 
highlighting and double-clicking it, make the changes, close the window and click yes in the pop-up 
box to save the changes. 
 
When you have finished typing the data for your reference, it should look a bit like this.  
 

 

7. Editing References in EndNote 

In the library window, double-click on one of the references that you have entered. This will open it for 
editing. 

You can change or delete anything or add additional information for your own use in any of the empty 
fields (e.g. notes, research Notes, url). 

Close the reference  (Ctrl+W) when you have finished editing and this will save the changes. Clicking 
on the X button in the top right-hand corner of the New Reference window will also close the 
reference (but be careful not to close the whole EndNote library by clicking on the larger X.) 

If you want to delete a reference from your library, click on it once in the library window to select it, 
and then either hit the delete key or go to the References option on the menu bar, and select Move 
References to Trash. 

 
 
 
 



 
8. Importing References from Library Databases  
 
You can search for references using University of Auckland Library databases, and import these 
references into EndNote. This is usually quicker and more accurate than typing them in manually. 
 
Direct exporting is the quickest and easiest method for getting references from a database into 
EndNote. Not all databases offer a direct export option and the databases which do offer direct export 
all do it slightly differently. To find out if a database supports direct export and to get instructions 
check the information on the database Connect Page.  
 
Eg:  Here’s the database Connect page for Business Source Premier – scroll down to get the 
EndNote instructions 
http://www.library.auckland.ac.nz/databases/learn_database/public.asp?record=bsp 
 
NOTE: Always carefully check the records you have exported from databases into EndNote as there 
may be inaccuracies and some records will need editing after import.. 
 
The following demonstrates direct exporting from Business Source Premier 
 
1. Open the Business Source Premier database 
2. Search for business ethics in title and restrict to Scholarly (Peer Reviewed) Journals 
 
 

 
 
 
3. From the search results which appear add one or more reference to the folder. 
 
 

http://www.library.auckland.ac.nz/databases/learn_database/public.asp?record=bsp�


 
 
4. Click on the Folder icon at the top right of the screen 
 

                     
 
 
 
5. Select the item(s) you wish to export and click on the export icon 
 

                     
 
 
6. Click on ‘save’ and open the relevant EndNote library. 
7. The references are exported automatically. These references will display in a new window, called 
Imported References, allowing you to check each reference for accuracy, and to edit or add your own 
notes. To show your complete EndNote library again, including the newly imported references, click 
on All References. 
 
 
 
9. Using groups 

Rather than having separate EndNote libraries for separate topics which is NOT recommended, you 
can group references within the one library by subject.   

To set up a group, click on Groups on the top menu bar, and select Create Group from the drop-
down menu. This will open a box in the Groups Pane on the left-hand side of the library window, 
where you can type a name for the group. 



 

 
     New group 
 
   
 

 
 
To add a reference to a group, highlight the reference in the library window. Click on Groups on the 
top menu bar, click on Add References To from the drop-down menu, and then select the name of 
the group. 
 

 
 



  

 
 
 
 
 
 
 
 
 
10. Searching for References in a Library 
If you want to search your EndNote library for references that contain certain information you can use 
the search function. 
 

• In the preview pane below your reference list, click the Search tab. 
• Select the Field(s) you want to search, enter your terms and click Search. The relevant 

references will be displayed. 
 
11. Adding Attachments 
 
You can attach files with full-text journal articles (e.g.pdfs) in your EndNote library. This allows you 
to conveniently store articles and use EndNote as a file management tool as well. 
 
There are two ways to add files to EndNote records. 
 
1. Drag-and-drop the file into the relevant EndNote reference 
or 
2.. References >> File Attachments >> Attach File 
 
Attaching Files using Drag-and-drop 
Select the reference in EndNote, and drag the file from the desktop to the reference. 
 

 
 
 

More on groups 

• Another way of adding references to a group is by right-clicking on the reference and 
selecting the group.  Or drag-and-drop the reference(s) onto the group name.  

• You can organise your groups into group sets which add another level of organisation.  
• You can set up Smart groups which have a search filter.  When a new reference is 

added to your library, it is checked against the search query. If it matches, it is 
automatically added to the smart group. 



 
 
 
 
12. Finding Full Text 
 
There is a Find Full Text facility in EndNote X3 but it only works with a narrow range of databases, 
which does not include the major business databases such as ABI/Inform and Business Source 
Premier. It will, however, work with Science Direct which does contain a range of business material so 
may be worth trying out. 
 
In your EndNote library select the reference for which you want to find full-text (or hold down the “Ctrl” 
key to select multiple references). 
 
From the References menu, select Find Full Text, or if you have a reference open for editing, use 
the right-click on your mouse and select Find Full Text from the menu. 

Alternatively use the Find Full Text icon on the toolbar  

 
13. Using Online Search 
 
In some cases you can search a database over the Internet without leaving EndNote. You can then 
select references from the database and import them directly into your EndNote library.  This can be 
useful for library catalogs including the University of Auckland library but it’s not recommended for 
journal databases.   
 
Not all databases can be searched using a connection file, it depends on the way the database works.  
 
In the top left-hand corner of your EndNote library window, click on the Online Search Mode button.  
 

 
 

Click on the Online Search button on the library toolbar. A list of available connection files will 
appear. 

After you have 
added the file, there 
will be an icon in the 
File Attachments 
field in the record, 
as well as on your 
library window. 
 



 
 

Highlight the Connection file you want to use, then click the Choose button, and EndNote will use 
your Internet connection to access the database. (You need to be connected for this to work). 

When the connection to the database is successfully established, EndNote opens an Online Search 
dialogue in the Tab Pane of the library window. 
 

 

Enter your search terms, click on the Search button and you will see a dialogue box stating the 
number of references which match your search: 

 

Click on the OK button and the references will be displayed. Select the references that you would like 
to transfer to your library by holding down the Ctrl key and clicking on the required references. 



Click on the Copy to Local Library button on the library toolbar. The references will be 
transferred to your library. 

When you have finished searching, click on the Local Library Mode button to return to your library. 
 

 
 
 
14.  EndNote and Microsoft Word 
 
When you install the EndNote software extra files will be inserted into your Word software. Open 
Word 2007, and you will see an EndNote X3 tab on the ribbon. Click on the EndNote X3 tab to see 
the EndNote tools . 
 
 

 
 
Open your Word document.  Select the output style by using the drop down arrow in the Style window.  
Examples of output styles are APA, MLA, Harvard. The University of Auckland Business School 
currently uses APA 5th or APA 6th edition 
 
If you do not see the style you want listed, choose Select Another Style to browse for the style you 
want. Click Choose to add that style to the toolbar 
 
If you still do not see the style you want, check out the EndNote website at 
http://www.endnote.com/support/enstyles.asp for additional output styles. 
  
15.  Inserting References 
 
In your document, go to the end of the first sentence, and insert a space before the full stop. 

Click on the Insert Citation button  on the EndNote add-in ribbon. This opens a search 
window.  Search for a relevant reference from your library 
 



 
 
 
Highlight the reference(s) you want to insert into your document and click Insert. 
 
EndNote will instantly format the citation in the text and produce a list of references at the end of the 
document in the style which is currently selected. 
 
NOTE: If you do not have Instant Formatting enabled then you may see a temporary reference which 
may look something like {Askew, 2004 #198}. To enable “Instant Formatting” go to the middle section 
of the  Endnote ribbon, click the bottom corner arrow next to Bibliography. Click the Instant 
Formatting tab, click Turn On and click OK. 
 
 
16. Editing / Removing a citation in a formatted document 
 
Click on the in-text citation to highlight it: 
 
In your document under the EndNote X3 tab menu, in the Citations group, select Edit Citation(s). 
 

• To remove a citation, click the Remove button and then click OK. 
• To remove the author or year in the in-text citations, check the box next to Exclude author or 

Exclude year and then click OK. 
• In your document under the EndNote X3 tab menu, in the Bibliography group, select  Update 

Citations and Bibliography to implement the changes. 
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